
 

  

 

 



ISBN: N/A  

SWsoft.  

13755 Sunrise Valley Drive  

Suite 325  

Herndon  

VA 20171 USA  

Phone: +1 (703) 815 5670  

Fax: +1 (703) 815 5675  

  

© Copyright 1999-2007,  

SWsoft Holdings, Ltd.  

All rights reserved  

  

Distribution of this work or derivative of this work in any form is prohibited unless prior written 
permission is obtained from the copyright holder.  

 Solaris is a registered trademark of Sun Microsystems, Inc. 

X Window System is a registered trademark of X Consortium, Inc. 

Intel, Pentium, and Celeron are registered trademarks of Intel Corporation. 

MS Windows, Windows 2003 Server, Windows XP, Windows 2000, Windows NT are registered 
trademarks of Microsoft Corporation. 

IBM DB2 is a registered trademark of International Business Machines Corp. 

SSH and Secure Shell are trademarks of SSH Communications Security, Inc. 

MegaRAID is a registered trademark of American Megatrends, Inc. 

PowerEdge is a trademark of Dell Computer Corporation. 

Request Tracker is a trademark of Best Practical Solutions, LLC 

ActiveSite Compiller v4 is a trademark of Intorel, Inc. 

XML-RPC Library under MIT License 

 

 

 



 

 3 

 

Contents 

Preface 5 

About Sitebuilder ........................................................................................................................... 5 
About This Guide ........................................................................................................................... 5 
Who Should Read This Guide ....................................................................................................... 5 
Typographical Conventions ........................................................................................................... 6 
Feedback ....................................................................................................................................... 6 

Getting Started with Sitebuilder 7 

Overview of Main Steps to Create Site ......................................................................................... 8 
Logging In to Sitebuilder ................................................................................................................ 9 
Learning Sitebuilder Interface ..................................................................................................... 10 

Working with Lists ............................................................................................................. 12 
Starting to Work with Sitebuilder ................................................................................................. 14 
Getting Help ................................................................................................................................. 15 

Choosing Type of Created Site 16 

Creating Site Design 17 

Selecting Design Template for Site ............................................................................................. 19 
Selecting Color Scheme .............................................................................................................. 19 
Selecting Banner ......................................................................................................................... 20 
Selecting Menu Style ................................................................................................................... 20 
Uploading Logo ........................................................................................................................... 21 
Specifying Site's Title, Subtitle, and Footer Message ................................................................. 21 
Buying Pictures from Fotolia ....................................................................................................... 22 

Creating Site Structure 23 

Types of Pages ............................................................................................................................ 25 
Structuring Your Site ................................................................................................................... 26 

Adding Pages .................................................................................................................... 27 
Changing Position of Pages .............................................................................................. 27 
Renaming Pages ............................................................................................................... 27 
Removing Pages ............................................................................................................... 28 

Choosing Site Language and Customizing Settings for Display of Numbers, Currencies, Times and 
Dates ........................................................................................................................................... 28 

Populating Site with Content 29 

Setting Up Site Map..................................................................................................................... 30 
Renaming Pages ............................................................................................................... 30 
Specifying Keywords to be Used by Search Engines ....................................................... 31 
Providing Description to be Displayed in Search Results ................................................. 31 
Hiding Pages in Site Navigation ........................................................................................ 32 

Working with Text ........................................................................................................................ 33 
Applying Styles, Fonts, and Colors to Text ....................................................................... 33 



 

 Preface 4 

 

Formatting Paragraphs ..................................................................................................... 34 
Copying and Moving Text ................................................................................................. 34 
Finding and Replacing Text .............................................................................................. 35 
Checking Spelling ............................................................................................................. 36 
Undoing and Redoing Actions........................................................................................... 36 
Inserting Images ................................................................................................................ 37 
Inserting Links ................................................................................................................... 37 

Working with Tables .................................................................................................................... 40 
Inserting Tables ................................................................................................................. 40 
Adding Rows and Columns ............................................................................................... 40 
Removing Rows, Columns, and Cells ............................................................................... 41 
Formatting Tables ............................................................................................................. 42 
Merging Cells .................................................................................................................... 43 
Splitting Cells..................................................................................................................... 43 
Formatting Cells ................................................................................................................ 44 
Making Tables Available for Users with Impaired Vision .................................................. 45 

Modifying HTML Source of Web Pages ...................................................................................... 46 
Working with Modules ................................................................................................................. 47 

Adding Blog ....................................................................................................................... 48 
Adding Image Gallery ........................................................................................................ 52 
Providing Content for Download ....................................................................................... 57 
Adding Online Store .......................................................................................................... 58 
Adding Flash Intro ............................................................................................................. 67 
Adding Guestbook ............................................................................................................. 68 
Adding Forum .................................................................................................................... 70 
Providing Registration for Your Site Visitors ..................................................................... 73 
Adding Maps ..................................................................................................................... 75 
Adding Feedback Form ..................................................................................................... 78 
Adding RSS News Feeds .................................................................................................. 79 
Inserting Scripts to Your Web Pages ................................................................................ 79 
Conducting Polls and Online Surveys ............................................................................... 80 

Publishing Site 81 

Requirements to Publishing Location .......................................................................................... 83 
 

  



 

 5 

 

 
 

About Sitebuilder 

Sitebuilder consists of two parts: Wizard and Administrator Panel. 

With the Sitebuilder Wizard, you can create sites by simply choosing the design preset 
you like and adding text and images. And then you can add picture galleries, blogs and 
online stores with a few clicks. You do not need to know any markup or scripting 
languages to have a site. 

The Administrator Panel is a tool for managing and maintaining web sites created in 
the Wizard. 
 

About This Guide 

This guide instructs you how to create and publish sites on the Internet using the 
SWsoft Sitebuilder program. 

This guide covers the following steps of creating and publishing sites: 

1 Creating site design (see page 17)  

2 Creating and editing site structure (see page 23)  

3 Creating and editing site content (see page 29)  

4 Publishing a site on the Internet (see page 81)  

 
 

Who Should Read This Guide 

The target audience of this guide is regular users of Sitebuilder as well as guests, who 
are working with Sitebuilder in the guest mode, creating trial sites without publishing 
them on the Internet. 
 

C H A P T E R  1  

Preface 



 

 Preface 6 

 

Typographical Conventions 

The following kinds of formatting in the text identify special information. 

Formatting convention Type of Information Example 

Special Bold 

 

Items you must select, such as 
menu options, command 
buttons, or items in a list. 

Go to the QoS tab. 

Titles of chapters, sections, 
and subsections. 

Read the Basic Administration 
chapter. 

Italics Used to emphasize the 
importance of a point, to 
introduce a term or to 
designate a command line 
placeholder, which is to be 
replaced with a real name or 
value. 

The system supports the so 
called wildcard character 
search. 

Monospace The names of style sheet 
selectors, files and directories, 
and CSS fragments.  

The license file is located in the 
httpdocs/common/license 

directory. 

Preformatted On-screen computer output in 
your command-line sessions; 
source code in XML, C++, or 
other programming languages. 

# ls –al /files 

total 14470 

Preformatted Bold What you type, contrasted with 
on-screen computer output. 

# cd /root/rpms/php 

 
 

Feedback 

If you have found a mistake in this guide, or if you have suggestions or ideas on how to 
improve this guide, please send your feedback to userdocs@swsoft.com. Please 
include in your report the guide's title, chapter and section titles, and the fragment of 
text in which you have found an error. 

mailto:userdocs@swsoft.com
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This chapter describes your first steps with the Sitebuilder Wizard. 

In this chapter: 

Overview of Main Steps to Create Site .............................................................. 8 
Logging In to Sitebuilder .................................................................................... 9 
Learning Sitebuilder Interface ............................................................................ 10 
Starting to Work with Sitebuilder ........................................................................ 14 
Getting Help ...................................................................................................... 15 
 
 

C H A P T E R  2  

Getting Started with Sitebuilder 
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Overview of Main Steps to Create Site 

As a rule, the process of working on a site includes three main stages: planning, 
implementation, and site updating or maintenance. 

Planning: The first and most essential stage in any project is planning. Before starting 
with Sitebuilder, think about the purpose of your site and its target audience. After this, 
decide where your site will be stored, or, in Internet terminology, hosted. This stage is 
beyond the scope of this document. Because Sitebuilder is often provided with a web 
hosting package, we assume that you already have a web space for publishing your 
site. Then, you create a structure of your future site and prepare its contents, including 
text and graphics. The planning stage is extremely important because it eventually 
determines the usefulness of your site. 

Implementation: The next stage is the implementation of your site. The five-step 
Sitebuilder Wizard takes you through the entire process of creating your site, from 
initial design to publishing and maintenance. The following is an overview of the main 
steps required to create a site using Sitebuilder:  

1 To create a site, open the Sitebuilder Wizard. You can start working with the Wizard 
anonymously, without supplying login and password.  

2 Complete the first four Wizard steps (select the design, create the site structure, 
add site contents, add site modules and provide extra information for search 
engines).  

3 Go to the Publish step and start the publication process. If you do not have a 
Sitebuilder account and work with the program in demo mode, the site you create is 
temporary and cannot be published on the Internet until you buy hosting. After you 
purchase hosting services from your provider, you will be provided with a domain 
name. The Sitebuilder provider will point your Sitebuilder account to your domain 
name, and after publication, your site will be available on the Internet. 

Maintenance: When you complete the above steps, your site becomes available for 
visitors. It is critical to keep your site content fresh because this is a good way to show 
your attitude to customers and services. Therefore, update your site on a regular basis. 
All you need to do is to log in to the Sitebuilder, edit the content, and click Publish. 
Sitebuilder will transfer the updated content to your hosting location. 

For detailed instructions on what to do on every step of creating your site, see the 
following chapters. 
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Logging In to Sitebuilder 

Anonymous users, who can work in the Sitebuilder Wizard in demo-mode only, do not 
need to provide any access credentials - they are taken to the Wizard by following a 
promotional link to the trial version of the Wizard (the link is distributed by Sitebuilder 
provider over the Internet or in some other ways). 

 To log in to the Sitebuilder Wizard using your site owner account: 

1 Open your Internet browser. 

2 Enter the URL that your Sitebuilder provider has given to you into the 
address bar of your browser. 

For example, http://hostname:port/Admin 

3 Enter you user name and password and click OK. 

4 You can proceed to the Wizard in the following ways:  

 If your Sitebuilder administrator has already registered a site for you, then on 

the navigation pane, click Sites and click the  Edit site in Wizard icon opposite 
the site name. 

 If no site is registered for your account yet: 

 Go to http://hostname:port/Wizard or click Go to SWsoft Sitebuilder 

Wizard on the Desktop - a site (with default name and empty publishing 
settings) will be automatically registered in the Administrator Panel, and you 
will be taken to the Wizard. 

 Go to navigation pane > Sites > Add New Site and specify all required 

parameters to register your site. Click OK. Now click the  Edit site in Wizard 
icon opposite the site name 
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Learning Sitebuilder Interface 

In Sitebuilder, a site is created in five steps. Each step has its own working and 
navigation principles, which will be covered in respective sections further in this guide. 
Here we will outline the general principles of working with the Sitebuilder Wizard 
interface, and enumerate elements present on all Sitebuilder screens. 

 

Figure 1: Sitebuilder Wizard Interface 

Every Sitebuilder Wizard window contains the following elements: 

1 Logotype image. The default logotype is a Sitebuilder image linked to the SWsoft 
official site. This image can be customized by your Sitebuilder provider. 

2 Top help string, which provides short instructions about the operations you can do on 
this page and displays the result of your last action. 

3 Shortcuts used to switch between the five Sitebuilder Wizard steps. The step you are 
currently on is highlighted in color. 

4  Feedback button, which enables you to submit your opinion or suggestions on 
Sitebuilder usability and functionality. 

5  Support button, which by default, opens Sitebuilder Online Server Support 
screen on the SWsoft official site, where you can fill in the form to request the help 
of SWsoft technical support team. This link can be customized by your Sitebuilder 
provider. 

6  Help button, which opens the online version of this guide. 

7  Go to Admin Panel button, which takes you to the Sitebuilder Administrator Panel.  

8  Log out button, which finishes the current session with the Sitebuilder Wizard. 
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Note: Buttons Go to Admin Panel and Log out are not shown to users working in 
Sitebuilder in demo mode (as anonymous users).  

9 Work area, which displays the interface options available on the current step. 

10  Back button, which enables you to get to the previous step of the Wizard (you 
can also return to another step by selecting the corresponding tab in the top frame 
area). 

11  Preview button, which allows you to preview the site at any stage of its creation. 

12  Next button, which takes you to the next step of creating your site (you can also 
go to the next step by clicking the required tab in the top frame area).  
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Working with Lists 

When setting up page or block modules on the Edit step of the Sitebuilder Wizard, you 
will see lists of various system objects (blog posts, online store orders, etc.).  

In such a list, each object record is a table row displaying the object name and the 
relevant parameters of the object (for example, for each forum topic, the author of the 
topic, the category the topic belongs to, the date of last the update, and the number of 
replies to the topic are displayed). Above and below each list, the total number of items 
contained in the list is displayed. Below the list, you can adjust the number of items to 
be displayed per page (10, 25, or 100). In multi-page lists, you can navigate between the 
pages by clicking the page number shortcuts above and below the list. To go to the 
first/last page of the list, click First Page or Last Page, accordingly. 

In lengthy lists, you can find items using the search function, or sort items by the 
available parameters. To find an item, type a search criterion into the input box above 
the list, and click Search. The list will show the items matching the search criterion. To 
return back to viewing all items, click Show All.  

 

Figure 2: Searching for Objects 

In some lists, you can filter items by a number of parameters by selecting one of them 
from the drop-down box (for example, on the Orders tab of your eShop page, you can 
filter out orders of certain status: All, New, Paid, Processed, Backorder, Cancelled, 
Completed, Failed). 

 

Figure 3: Filtering Objects 

Note: All the above described principles also apply to the list of design template 
categories on the Design step of the Sitebuilder Wizard. For information on using these 
options on the Design step, read section Creating Site Design (see page 17). 

To choose a list object for further operation, select the check box to the left of the 
object's name. 
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Figure 4: Selecting Particular Objects in a List 

To choose all objects in the list, select the check box at the head of the column. 

 

Figure 5: Selecting All List Objects at Once 

To perform operations with certain objects in a list, select the required objects and click 

an operation shortcut above the list (for example,  Remove Selected). 

In the list of guestbook messages, the status of a message is indicated by a status icon 

in the Status (S) column (not archived  or archived ).  

In most lists, individual operation shortcuts are displayed for each item. For example, 
for each product category on the Categories tab on the eShop page, there are arrows 
( and ) used to change the order in which the categories are displayed on the site 

page; and the  Edit icon used to open the categories in editing mode. 

In most lists, you can configure or edit a list object by: 

 Clicking the object name, if it is clickable (for example, the post names on the 
Content tab of the Blog page) 

 Clicking the  Edit icon for this object in the list (for example, for a product on the 
Products tab of the eShop page) 

In some lists, you will also see shortcuts to managing the objects' dependent items - 
such as the View/Edit Comments shortcut for each blog post on the Content tab of the Blog 
page. 
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Starting to Work with Sitebuilder 

The Overview page provides quick access to and contains short description of each of 
the five steps required for creating a site in Sitebuilder. 

 

Figure 6: The Sitebuilder Wizard Overview Page 

The five Sitebuilder Wizard steps are as follows: 

1 Start. Enables you to choose whether to create a site from scratch or create a site 
using one of the proposed site templates (site-blog, site-photo gallery, etc.).  

2 Design. Enables you to configure your site layout, color scheme, menu style, logo 
and banner, as well as to set up text elements appeared at the background of your 
site, such as title phrase or copyright notice. 

3 Pages. Enables you to add and structure web pages on your site. 

4 Edit. Enables you to create and edit your site content. 

5 Publish. Enables you to put your site online. 

For anonymous users, on the Overview page, the  Interface language box is displayed 
allowing to select the language of the Sitebuilder Wizard interface. 

To start creating your site, click Start.  
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Getting Help 

The Sitebuilder help system has been created to assist you in solving problems you 
might encounter when creating your site. To find the information you need, you can do 
the following: 

 Use on-screen help. It is the easiest and quickest way to get instant help with your 
immediate tasks. Using help topics will not interrupt your work flow. The Top help 
string contains short instructions on the operations that are available on the current 
page and displays the result of the last command you have performed on the 
Sitebuilder page. 

 Use FAQ. For the fastest way to solve your problems with Sitebuilder, check out the 
Sitebuilder FAQ page (http://faq.swsoft.com), which provides instant access to 
solutions for a variety of issues. Select the Sitebuilder category and view the list of 
FAQs related to Sitebuilder. 

 Go to online forum. If you failed to solve your problem using the FAQs published on 
SWsoft site, join our online forum (http://forum.swsoft.com/). Here, all users can post 
questions, exchange ideas, and troubleshoot common problems. Note that SWsoft 
does not provide official support through this forum. 

 Contact technical support. If you have any problems or questions that are not 

covered in the user documentation or FAQs, click the  Support button at the top 
right of the Sitebuilder window to submit a request to your support representative. 

 

 

http://faq.swsoft.com/
http://forum.swsoft.com/
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The first step of creating site with Sitebuilder is to choose whether you want to start 
creating your site from scratch or use one of proposed site templates (the so-called site 
families). By default, there are two site templates available - blog and image gallery, 
but the Sitebuilder administrator can extend this list by creating custom site templates 
and including them in your service plan. 

To choose the type of a created site, go to the Start step and click the required site 
family to select it. 

The Start page looks as follows: 

 

Figure 7: Step 1. Choosing the Site Type 

The chosen site family is indicated with the  sign.  

Having selected a site family, click Next at the bottom of the screen to proceed to 
configuring the design of your site. 

 

C H A P T E R  3  

Choosing Type of Created Site 
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In Sitebuilder, you can build the graphic design of your site by combining the provided 
presets with your custom design elements which you can upload to Sitebuilder. 
Sitebuilder offers design presets of several types, including: design templates, color 
schemes, page banners and site menu styles. The custom elements you can upload 
are the page banner and logo. Besides uploading your own banner and logo, you 
personalize your site by specifying your own the site title, subtitle and footer message. 
Below you will find a step-by-step instruction on designing your site in Sitebuilder. 

The Sitebuilder Design step screen looks as follows. 

 

Figure 8: Step 2. Creating Site Design 

The work area of the screen contains the following elements: 

1 Design template selection area, which provides the functions facilitating the choice of 
a site design template (see page 19). When you choose to display All categories, this area 
shows all available design templates. 

2 Design template preview window displaying the currently selected template. Click 
this window for full-size preview of the template. The chosen design template, color 
scheme and menu style are shown in red frames in the corresponding areas of the 
screen. 

3 Color schemes area, where you can choose the colors for your site (see page 19).  

C H A P T E R  4  

Creating Site Design 
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4 Banners area enabling you to select or upload a banner for your site (see page 20).  

5 Menu styles area, where you can choose the appearance of the site menu (see page 20).  

6 Logo area enabling you to upload your custom logo (see page 21).  

7 Site info area where you can provide the information to be displayed within the banner and 
in the footer of your site pages (see page 21).  

8 The design template list navigation area.  

Read this chapter to learn how to use these options to create your site design. 

In this chapter: 

Selecting Design Template for Site ................................................................... 19 
Selecting Color Scheme .................................................................................... 19 
Selecting Banner ............................................................................................... 20 
Selecting Menu Style ......................................................................................... 20 
Uploading Logo ................................................................................................. 21 
Specifying Site's Title, Subtitle, and Footer Message ........................................ 21 
Buying Pictures from Fotolia .............................................................................. 22 
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Selecting Design Template for Site 

On this step, you choose the general graphic and layout concept of the site page - the 
site design template. For more convenience, design templates are grouped into 
categories - the most frequently encountered site types. Your choice of the design 
template defines the choice of available color schemes, menu styles and page banners 
further on this step.  

The list of available site design templates is determined by your service plan. 

 To select a design template for your site: 

1 On the Design step, select a template category from the Category list.  

The default design template which goes with the category is displayed in the main 
design preview window; the alternative ones - in smaller windows beside the main 
window.  

2 Select a design template. 

Click the design template you like to select it for your site. The selected template 
appears in the main design preview window. By selecting a design template you 
can view the color schemes, menu styles and the page banner which go with it. 

To choose a design template on pure aesthetic grounds (not by category), select All 
categories to display all available templates and click the desired one to select it.  

Selecting Color Scheme 

For each design template, three color schemes are available. No custom color 
schemes can be uploaded to Sitebuilder.  

To select a color scheme for your site, on the Design step, in the Color schemes area, 
select the color scheme you like. The selected color scheme is outlined with a red 
frame. 
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Selecting Banner 

In Sitebuilder, banner is a large image of rectangular shape which serves as a central 
element of the page layout. Each design template offers a choice of available banners. 

 To select a banner: 

1 On the Design tab, in the Banners area, click the down arrow to expand 
the list of available banners. 

2 Select the banner you need. 

 

You can also upload a custom banner for your site.  

 To upload a banner: 

1 Click Browse in the Banners area. 

2 In the Browse window, find and select the banner image you want to 
upload. 

3 Click Open in the Browse window. 

4 Click Upload in the Banners area. 

 
 

Selecting Menu Style 

Menu style defines the visual appearance of the menu items on your site. 

To select a menu style, on the Design step, in the Menu styles area, select the style you 
like. The selected style is outlined with a red frame. 
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Uploading Logo 

In Sitebuilder, logo is a small image displayed at the top of each page, within page 
banner. The maximum size of logo image is 320x320 pixels; the supported image files 
formats are *.bmp, *.gif, *.jpg, *.png. 

 To upload a logo: 

1 On the Design step, click Browse in the Logo area. 

2 Select the logo image you want to upload from your computer. 

Prior to uploading the logo, observe the dimension and format requirements to the 
logo image. 

3 Click Open in the Browse window. 

4 Click Upload in the Logo area. 

To remove logo from your site design, click Clear. 

To restore logo to its default state, click Restore Default. 
 

Specifying Site's Title, Subtitle, and Footer 
Message 

Site title, subtitle, and footer message are text elements appeared at the background of 
your site: site title and subtitle are displayed within the site banner, and footer message 
is put at the bottom of every page of your site. 

To specify your site title, subtitle phrase and footer message, on the the Design step, fill 
in the fields in the Site info section: 

 In the Site title field, provide a short description of your site. On business sites, this 
is usually a company name. 

 In the Subtitle field, provide any phrase which reflects the concept and objectives of 
the site. This phrase will be displayed below the site title in smaller font. On 
business sites, this is usually a corporate slogan. 

 In the Footer message field, provide the copyright notice or any other information of 
similar kind - disclaimers, contact information, etc., which you would like to place in 
the page footer. 
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Buying Pictures from Fotolia 

In Sitebuilder, you can buy images from Fotolia (http://www.fotolia.com/swsoft/) - the 
first worldwide social marketplace for royalty free stock images, directly from the 
Sitebuilder Wizard. As an SWsoft customer, you can a get 20% discount on Fotolia 
pictures.  

 To purchase images from Fotolia: 

1 On the Design step, click the  Buy pictures shortcut. 

2 Follow the instructions provided on the Fotolia Web site to purchase 
images. 

 

 

http://www.fotolia.com/swsoft/
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A site consists of several pages linked together to present information in an ordered 
way. Using Sitebuilder, you can arrange the pages in the two levels of hierarchy: top 
level pages and second level pages. Therefore, before this stage you must clearly 
understand how you intend to structure your site.  

Note: The maximum number of pages you can create using Sitebuilder is regulated by 

your service plan.  

To facilitate your work with Sitebuilder, pages are grouped into page sets - pre-defined 
site structures designed for displaying certain types of content. The default page set of 
your site is determined by the type of site you chose on the Start page of the Sitebuilder 
Wizard.  

On the Pages step, you can build any possible site structure by organizing the available 
types of pages into a hierarchy which addresses your needs. Find out about the types of 
pages (see page 25) offered by Sitebuilder and about the process of adding pages (see 
page 27) and site structuring (see page 27). 

The Pages step screen provides the following functionalities to facilitate structuring your 
site: 

 

Figure 9: Step 3. Creating Site Structure 

C H A P T E R  5  

Creating Site Structure 
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1 Page sets area allows to choose a page set. The selected page set is shown in red 
frame.  

2 Standard pages area displays the structure of the page set chosen in the Page sets 

area. You can expand or collapse this section by clicking the  or  icons in the 
top bar of the section. 

3 Your site structure area shows the final structure of your site. 

4 Site regional and language options area allows you to set the site language and the 

format of numeric data. You can expand or collapse this section by clicking the  

or  icons. 

5 Special pages area displays all available types of pages which can be added to your 
site structure: one common text page, and all available page modules. You can 

expand or collapse this section by clicking the  or  icons. 

6  and  buttons allow you add or remove pages from the site 
structure. 

7 Page position area enables you to organize the hierarchy of pages (see page 26) in the 
site map, and to rename pages. 

Read this chapter to know how to use these options. 

In this chapter: 

Types of Pages ................................................................................................. 25 
Structuring Your Site ......................................................................................... 26 
Choosing Site Language and Customizing Settings for Display of Numbers, 
Currencies, Times and Dates ............................................................................ 28 
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Types of Pages 

In Sitebuilder, there are two types of pages: 

 Standard (common) pages - ordinary pages used for displaying text information. 

Such pages are marked with  icons in the site map. 

 Special pages - page modules which extend the site functionality. Each module is 
designed for a certain purpose and is identified by its own icon. There are the 
following types of page modules in Sitebuilder: 

  Blog (see page 48). Supports a standard set of blog functionality: posting, 
commenting, content categorizing, etc. A Blog page is very convenient for 
organizing the News, Events and similar pages of your site.  

  Image Gallery (see page 52). Supports image upload, batch image upload with 
group editing functions, etc. 

  File Download (see page 57). Allows to provide various content for download 
to your site visitors.  

Note: Each File Download page can hold only one file. To provide several files 

for download, add several File Download pages to your site structure.  

  eShop (see page 58). Supports basic online store functions: shopping cart, 
multi-currency, categorized product catalogue with thumbnail upload capability, 
shipping cost support. Provides integration with 6 payment systems, including 
PayPal, Authorize.Net, BluePay, 2Checkout.com. 

  Flash Intro (see page 67). A pre-designed flash introduction to your site. You 
can choose between several designs of the intro and insert your own text 
information into it. 

Note: The Flash Into module is the only page module that requires no database 

connection and therefore can be included in a static site. 

  Guestbook (see page 68). A standard guestbook. 

  Forum (see page 70). A standard forum engine which supports threading, 
categorizing, etc. 

  Registration (see page 73). Allows you to set up voluntary user authentication 
on your web site. 

The list of available modules is determined by your service plan. In Sitebuilder, you can 
add as many page modules of one kind to your site as you like (excepting Flash Intro 
and Registration).  
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Structuring Your Site 

You can build and edit your site structure on the Pages step of the Sitebuilder Wizard. 
To facilitate your work with Sitebuilder, pages are grouped into page sets - pre-defined 
site structures designed for displaying certain types of content. The default page set of 
your site is determined by the type of site you chose on the Start page of the Sitebuilder 
Wizard. You see this default page set highlighted in the list of page sets, its structure is 
displayed in the Your site structure box on the right. You can modify the proposed site 
structure as desired by adding pages from other page sets (or even whole page sets), 
renaming pages, changing pages hierarchy, or removing pages from the Your site 
structure box. 

The list of page sets available depends on your service plan and can be extended only 
by your Sitebuilder administrator. The structure of each page set is shown in the 
Standard pages area after you select the page set in the list. 

The Special pages area shows a list of special pages, or modules which you can add to 
your site, plus one common site page which you can use as an ordinary text page. To 
learn which modules are available, refer to Types of Pages (see page 25), earlier in this 
section. 
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Adding Pages 

 To add pages to the site structure: 

1 Select the necessary pages in the Standard pages or Special pages area.  

Note: The module titles in the page set may differ from their original names. For 

example, a page  Photo of the Personal Page page set represents the  Image 
Gallery module. You can identify a module by its icon. 

2 Click .  

Or just drag and drop needed pages into the Your site structure box. 

You can add as many modules of one type to your site as you wish - except for the 
Flash Intro and Registration modules. These modules can be added to your site only 
once. 

Changing Position of Pages 

 To change the pages hierarchy: 

1 Select the required page in the Your site structure box. 

2 Use required buttons in the Page position area: 

 To move a page from the second level to the top level of the site structure, click 
Left. 

 To move a page from the top level to the second level, click Right. 

 To move a page up at the same level, click Up. 

 To move a page down at the same level, click Down. 

 
 

Renaming Pages 

 To rename a page: 

1 Select the page in the Your site structure box and click Rename. 

Or just double-click the page's name to make it editable. 

2 Provide a new name for the page. 

3 Press ENTER. 

If you choose to rename the page at a later stage, you can use the Page title field on the 
Edit step of the Sitebuilder Wizard. 
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Removing Pages 

To remove a page from the site map, select the page in the Your site structure box and 

click . 

Note: In Sitebuilder, you cannot delete all pages from the Your site structure area. In 
case you need to clear the space - for example, before setting up a completely new site 
structure, we recommend to select all pages, except one, delete them, add the 
necessary pages to the site, and then delete or reuse the old page.  
 

Choosing Site Language and Customizing 
Settings for Display of Numbers, Currencies, 
Times and Dates 

The language of Sitebuilder interface and the language of your site can be configured 
independently. You may need this option if you want to create a site in a language 
which is not in the list of available Sitebuilder interface languages. In that case, it is 
possible to select the desired language of your site on the Pages step. The choice of the 
language determines the format of numbers, the site currency, and also the format of 
date and time records everywhere on your site. 

 To select the language for your site and the format of displaying numbers, currencies, 
times and dates: 

1 Go to the Pages step. 

2 Select the language of your site content and modules interface from 
the Interface language list. 

3 Select the type of formatting standard from the Standards and formats list. 

The sample of the selected standard is displayed under the Standards and formats 
list. 
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In Sitebuilder, creating your site content means creating the content of each page 
constituting your site, and setting up functional modules you add to your site. You can 
do all this on the Edit step of the Sitebuilder Wizard. 

The Sitebuilder editor is organized in such a way that the information you type on the 
pages and the design of the pages are independent. Therefore, you can completely 
change the design for a page after you had typed a text on this page, without having to 
retype the information. 

The Edit step screen is structured in the following way: 

 

 

Figure 10: Step 4. Populating Site with Content 

1 Site map area shows the site structure created on the Pages step of the Wizard. By 
selecting a page in this area, you open its content for editing in the work area of the 
screen. In this area you can also adjust the general page parameters in the site map (see 

page 30). To hide the Site map section, click the  Hide site map icon. To restore the 

Site map area on the screen, click the  Show site map icon. 

2 Work area provides access to different functions, depending on the type of the edited 
page: 

 On ordinary text pages, the work area provides the space for creating the text 
content of the page (see page 33) with the help of the WYSIWYG editor, like on 
the screenshot above.  

C H A P T E R  6  

Populating Site with Content 
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 On special pages, or page modules, the work area provides the module editor 
screen, where you can configure various parameters of the module on the 
respective tabs, and, in most cases, populate the module with content (for 
example, fill your online store catalogue with products). For information on 
working with lists of objects on module management pages, read section 
Working with Lists (see page 12). For more information about configuring and 
editing each module, see the respective sections further in this chapter. 

3 Modules area allows to embed block modules in text pages, by clicking and drag-
and-dropping the module icon to the required spot on the page. For some tips on 
using block modules, see section Working with Modules (on page 47). To hide the 

Modules section, click the  Hide modules icon. To restore the Modules area on the 

screen, click the  Show modules icon. 

 

In this chapter: 

Setting Up Site Map .......................................................................................... 30 
Working with Text .............................................................................................. 33 
Working with Tables .......................................................................................... 40 
Modifying HTML Source of Web Pages ............................................................. 46 
Working with Modules ....................................................................................... 47 
 
 

Setting Up Site Map 

If upon filling your site with content you decide to rename some pages, hide them in 
site navigation or provide them with some keywords or description to be used by 
search engines, you can do that on the Edit step, in the Site map area. 
 

Renaming Pages 

To rename a page, select it in the Site map area and provide a new name in the Page 
title field. This will rename the page in the site menu and in the browser's title bar. 
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Specifying Keywords to be Used by Search Engines 

The keywords should be carefully selected to reflect the page content, because they 
are used by search engines to find pages with requested information. 

To provide a page with keywords, select the necessary page in the Site map area and 
type the needed keywords in the Page keywords field. 

Providing Description to be Displayed in Search Results 

Description is displayed with the page title and URL when the page appears as the 
result of a user query on a search engine. Therefore, description should give the main 
idea of the page, so everyone could instantly understand what the page is about. 

To provide a page with description, select the necessary page in the Site map area and 
type the desired text in the Page description field. 
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Hiding Pages in Site Navigation 

In Sitebuilder, you can choose which site pages should be visible in site menu and 
which not. The page which you choose to be hidden will be accessible only by clicking 
a link placed on other pages of your site (or wherever you would like to place it). Note 
that when site visitor actually accesses a hidden page it appears in the site menu, and 
when they switch to another (not hidden) page, the hidden page disappears again. 

To hide a page in the site navigation menu, clear the Show this page in site map check 
box. In the Wizard interface, hidden pages are highlighted with grey color in the site 
map and in the site structure on the Pages step. You can hide both first and second 
level pages. 

To understand how hiding pages correlates with pages hierarchy, see the example 
below: 

Let the site structure look as follows: 

 Page 1 

 Page 2 (hidden) 

 Page 3 

 Page 3.1 (hidden) 

 Page 3.2 

 Page 4 (hidden) 

 Page 4.1 

 Page 4.2 (hidden) 

To understand the dependency of pages' visibility and position in the hierarchy, see the 
table below. 

Active Page* Visible Pages 

Page 1 Page 1, Page 3 

Page 2 Page 1, Page 2, Page 3 

Page 3 Page 1, Page 3, Page 3.2 

Page 3.1 Page 1, Page 3, Page 3.1, Page 3.2 

Page 3.2 Page 1, Page 3, Page 3.2 

Page 4 Page 1, Page 3, Page 4, Page 4.1 

Page 4.1 Page 1, Page 3, Page 4.1 

Page 4.2 Page 1, Page 3, Page 4.1, Page 4.2 

* active page is a page where site visitor is currently stands on 

 
 



 

 Populating Site with Content 33 

 

Working with Text 

This subsection describes the ways of working with textual information on your web 
pages. You will learn how to format characters and paragraphs, cut, copy, paste text, 
insert images and links, check spelling, and more. 
 

Applying Styles, Fonts, and Colors to Text 

 To apply formatting to a text: 

1 On the Edit tab, select the web page where you want to edit the text.  

2 Select the portion of the text you want to change. 

3 Apply the necessary formatting options: 

 Select a font from the Font list. 

 Select a font size from the Size list. 

 Select a style from the Paragraph style list. 

 Click the  Foreground color icon to choose a font color. 

 Click the  Background color icon to choose a background color. 

 Click the  Bold,  Italic,  Underline, or  Strike through icons to make the text 
bold, italic, underlined, or strikethrough respectively. 

 Click the  Subscript or  Superscript icon to make the text subscript or 
superscript respectively. 

4 To insert a special symbol into the text, click the  Insert Symbol icon 
and select a symbol. 
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Formatting Paragraphs 

 To apply formatting to a paragraph: 

1 On the Edit tab, select the web page where you want to edit the text. 

2 Select the text which you want to format. 

3 Apply necessary formatting commands: 

 To align the text, click the  Align left,  Align center,  Align right, or  Justify 
icon on the toolbar. 

 To change the indentation of the selected text, click the  Indent or  Outdent 
icon on the toolbar. 

 To insert a horizontal rule, place a cursor in any place on the page and click the 
 Horizontal Ruler icon. 

 To start a new paragraph, click the  New Paragraph icon before the beginning of 
the new paragraph. 

 
 

Copying and Moving Text 

 To copy or move text: 

1 On the Edit tab, select the web page where you want to edit the text.  

2 Select the needed piece of the text. 

3 To move the text, click the  Cut icon 

4 To copy the text, click the  Copy icon. 

5 Place the cursor where you want the text to appear. 

6 Click the  Paste icon. 
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Finding and Replacing Text 

 To find a particular part of text in the page content: 

1 On the Edit tab, select the web page where you want to find the text.  

2 Click the  Find icon. 

3 On the Find tab, enter the text you want to find in the Find field.  

4 Indicate the area of the search, by selecting one of the following 
options: 

 Entire text. Entire text on the web page will be searched for indicated word or 
phrase. 

 Selection only. Only selected part of the text will be searched for indicated word 
or phrase. 

5 Indicate the direction of the search, by selecting one of the following 
options: 

 Up. The search is done in the upper part of the text, starting from the cursor 
position. 

 Down. The search is done in the lower part of the text, starting from the cursor 
position. 

6 Select the method of the search, by selecting either one of the 
following command options: 

 Match case. Only the text that exactly matches the case (uppercase and 
lowercase character formatting) is searched for the specified search pattern. 

 Match whole words only. Only the exact text you specified is searched for. 

7 Click OK to start the search. 

8 Click Find Next to look for the next mention of the search pattern. 

 To find and then replace a word or phrase: 

1 Click the  Find icon in the editor toolbar. 

2 Click the Replace tab. 

3 Enter the text you want to replace in the Find field. 

4 Enter the replacement text in the Replace with field. 

5 Click Replace. 

6 To replace all the mentions of the search pattern in the text, click 
Replace All. 
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Checking Spelling 

 To check spelling on the page: 

1 On the Edit tab, select the web page where you want to check the 
spelling. 

2 Click the  Spellchecker icon. 

In the Not in dictionary field, a possible spelling mistake is shown.  

3 If you are sure that the word found by the Spell Check editor is not 
misspelled, click Ignore to ignore this part of the text. 

To ignore all parts of the text, containing this word, click Ignore All.  

4 If you want to replace the misspelled word with the word in the 
Suggestions field, click Change. 

To change this word in the whole text, click Change All. 
 

Undoing and Redoing Actions 

To undo the last action, click the Undo icon.  

To redo the last undone action, click the  Redo icon. 
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Inserting Images 

 To insert an image to a web page: 

1 On the Edit tab, select the web page where you want to insert the 
image. 

2 Place the mouse cursor on the place in your site, where you want to 
insert the image. 

3 Click the  Image Manager icon. 

4 Click Browse and select an image to upload. 

Note:  
1. The maximum size of an image is 200KB. 
2. The supported graphics file formats are *.gif, *.jpg, *.jpeg, *.png, *.bmp  

5 Click Open in the Browse dialog box. 

6 If the file with the same name as the image you are uploading exists 
and you want to overwrite it, select the Overwrite if file with such name exists 
option. 

7 Click Upload. 

In the left dialog box, the name of uploaded image is displayed. 

In the right dialog box, you can preview the image by selecting its name in the left 
dialog box. 

8 Click Insert. 

 
 
 

Inserting Links 

Using the Sitebuilder editor, you can insert both internal and external links. Internal 
links point to other places of your site, taking the reader to related pages. External links 
pointing to other sites are often used to improve your site popularity and will direct 
visitors of your site to friendly sites (the so-called link exchange).  

Using the Sitebuilder hyperlink manager, you can add the following types of links: 

 Hyperlink (see page 38)  

 Links to the pages of your site (see page 38) 

 Anchor (see page 39)  

 E-mail link (see page 39) 
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Inserting Hyperlink 

Hyperlink is a reference in a hypertext document to another document or other 
resources. 

 To insert a hyperlink: 

1 Place the cursor where you want to insert a link (or select a text which 
you want to set as hyperlink).  

2 Click the  Hyperlink Manager icon. 

3 In the URL field, specify the web address which you want the link to 
point to. 

4 In the Link text field, specify (or change) the text that will make up the 
link. 

5 From the Protocol list, select the protocol to be used to access the 
linked resource (http, ftp, and other). 

6 From the Target list, select how the link will open (in the same window, 
in the new window, and so on). 

7 In the Tooltip field, type the text to be displayed when the cursor is 
hovered over the link. 

8 To set up the appearance of the link, select a desired style from the  
CSS class field. 

9 Click OK. 

 
 

Inserting Links to Pages of Your Site 

 To insert a link to a page of your site: 

1 Go to the Edit step and navigate to the page where you want to insert 
the link. 

2 Type/Select the text which you want to set as a link.  

3 From the Custom links list, select the page to which the link should lead. 
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Inserting Anchor 

Anchor is a word or a group of words that define the destination a hyperlink leads to. 
Anchors are very helpful in facilitating navigation through a great amount of text located 
in a single place. With this function you can provide the readers of the message with 
the easy way to jump from one part of the text to another. 

 To insert an anchor: 

1 Place the cursor where you want the link to lead to.  

2 Click the  Hyperlink Manager icon. 

3 Click the Anchor tab. 

4 Enter a name for the anchor and click OK. 

5 Select some text or an image that will be the hyperlink leading to the 
anchor.  

6 Click  the  Hyperlink Manager icon again. 

7 On the Hyperlink tab, select the newly created anchor from the Existing 
anchor field. 

8 Click OK. 

 
 

Inserting E-Mail Link 

If you want visitors of your site to contact you by e-mail, insert an e-mail link to your 
web pages. On a web page, this looks like your e-mail address underlined, and when a 
user clicks it, a mail program on his or her computer opens a "Compose New 
Message" window with your e-mail address specified as the recipient address. When 
placing e-mail links, you can also specify the default subject for the message. 

 To insert e-mail link: 

1 Select the text which you want to set as the e-mail link. 

2 Click the  Hyperlink Manager icon. 

3 Click the E-mail tab. 

4 In the Address field, type the needed e-mail address. 

5 In the Link text field, you can modify the previously selected text.  

6 In the Subject field, type the text that will be the subject of the e-mail 
message. 

7 To set up the appearance of the link, select a desired CSS class from 
the CSS class list. 

8 Click OK. 
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Working with Tables 

This section describes how to work with tables. You will know how to insert tables, add 
and delete rows, columns, and cells, merge and split cells, and drag tables to another 
location in your site content. 
 

Inserting Tables 

Tables are used to organize textual and numerical information in a convenient and 
clear way. They represent even large amounts of textual information in an easy-to-read 
format. Tables consist of grids formed by rows and columns. On web pages, tables are 
often used as a formatting tool to maintain the size and proportion of page borders in 
all browsers and output formats. Borders can be made invisible and information in a 
table appears as formatted in a desired way. For example, this can be useful when 
organizing the text in several columns, like in a newspaper. 

 To insert a table: 

1 Place the cursor where you want to insert a table.  

2 Click the  Insert Table icon. 

3 Move the mouse cursor to select the number of columns and rows you 
want. 

 
 

Adding Rows and Columns 

 To add a row or a column: 

1 Place the cursor in the table where you want to add a row or column. 

2 Click the  Insert Table icon: 

 To insert a row above or below the row where you placed the cursor, click the  

 Insert Row Above or the   Insert Row Below icon respectively. 

 To insert a column to the left or to the right of the column where you placed the 

cursor, click the  Insert Column to the Left or the  Insert Column to the Right 
icon respectively. 
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Removing Rows, Columns, and Cells 

 To remove a row, column, or cell: 

1 Place the cursor where you want to delete a row or a column.  

2 Click the  Insert Table icon: 

 To remove a row, click the  Delete Row icon. 

 To remove a column, click the  Delete Column icon. 

 To remove a cell, click the  Delete Cell icon. 
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Formatting Tables 

 To set the table properties: 

1 Right-click inside the table and click the  Set Table Properties icon in 
the context menu. 

2 On the Table Properties tab, set the following properties: 

 Width/Height. Specify the width and height of the table (in pixels or percent). 

 Background. Set the background color of the table. 

 Alignment. Align the table to the left, center, or right part of the page.  

 Cell spacing. Increase or decrease the space between the borders of the cells.  

 Cell padding. Increase or decrease the space between the content and the border 
of a cell. 

 Border. Set cell border width, color, and layout. 

 ID. Setting ID for a table provides some options for advanced table handling. 

 Background Image. Set an image as the table background. 

 CSS class. Specify table CSS class and style. CSS class is the predefined style 
which is applied to the selected text. 

Note: CSS class is the option for advanced users only. 

3 Click OK. 

Formatting Tables with CSS Classes 

CSS class provides easy and consistent way for formatting the tables. 

 To use a CSS class: 

1 Create a table. 

This process is described in detail in Inserting Tables, earlier in this guide. 

2 Open the Table Properties dialog box. 

3 Select a CSS class from the CSS class list in the Table Properties dialog 
box. 

4 Click OK. 
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Merging Cells 

 To merge cells: 

1 Place the cursor in the cell which you want to merge with another cell.  

2 Click the  Insert Table icon. 

3 To merge the cell with the cell to the right, click the  Merge Cells 
Horizontally icon. 

4 To merge the cell with the cell above, click the  Merge Cells Vertically 
icon. 

 
 

Splitting Cells 

 To split a cell in the table using the Insert Table dialog box: 

1 Place the cursor in a cell which you want to split (it must be a 
previously merged cell). 

2 Click the  Insert Table icon. 

3 Click the  Split Cell icon. 
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Formatting Cells 

 To configure the parameters of your table cells: 

1 Right-click inside the cell and select Cell Properties from the context 
menu. 

2 On the Cell Properties tab, set the following properties: 

 Content alignment. Align the content in the selected cell (vertically or horizontally). 

 Background. Set the background color of the cell. 

 Width/Height. Specify the width and height of the selected cell (in pixels or 
percent). 

 ID. Setting ID for a cell provides options for advanced cell handling (for 
advanced users and developers). 

 No wrapping. Enable/disable cell wrapping (that is if enabled, it forces new line 
when the text reaches the cell border). 

 Background image. Set an image as the background of the cell. 

 CSS class. Specify cell CSS class and style. CSS class is the predefined style 
which is applied to the selected text. 

3 Click OK. 
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Making Tables Available for Users with Impaired Vision 

MS Windows OS include tools that help users with impaired vision to use computer 
programs without feeling any discomfort. In order to generate content that can be 
interpreted by the Accessibility Tools integrated in MS Windows (such as the Narrator, 
the Magnifier, and the On-Screen Keyboard), Table Wizard includes an additional tab called 
Accessibility.  

The Narrator uses the information from the Accessibility table fields (heading rows, 
columns, caption alignment, and summary) to produce tooltip message for each table 
cell. Users with impaired vision can hear those tooltips as they hover over certain cells 
with their mouse cursor.   

 To make the table available for users with impaired vision: 

1 Right-click inside the table and click the  Table Properties icon in the 
context menu. 

2 Click the Accessibility tab. 

3 Enter a number of rows that will be set as headings in the Heading rows 
field. 

The maximum number of heading rows and columns depends on the total number 
of rows and columns in your table. 

4 Enter a number of columns that will be set as headings in your table 
in the Heading columns field. 

5 Enter the title of the table in the Caption field.  

6 Select the position of the caption relative to the table from the Caption 
alignment field. 

7 Enter a short description of the table to be vocalized in the Summary 
field. 

8 If your table contains heading rows/columns and the information 
specified in the table cells makes sense only together with the 
headings, select the Associate cells with headers check box. 

The tooltip message for the cells will include the names of the headings. 

9 Click OK. 
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Modifying HTML Source of Web Pages 

In Sitebuilder, textual and tabular information on your web pages is automatically 
converted into the HTML code. HTML, which stands for HyperText Markup Language, 
is a standardized language for presenting information, graphics, and multimedia on the 
World Wide Web. Using the Tag Properties feature, you can easily apply different 
styles and change properties of selected elements. 

At the bottom of the Sitebuilder editor window you can see the panel displaying the 
HTML structure of the line, on which your mouse cursor is now placed. 

For example, if you place the mouse cursor in a table, the HTML code structure will 
contain the following tags: TABLE, TBODY, TR, TD. The tag where the cursor stands is 
shown in bold. 

 To modify HTML source of a web page: 

1 On the Edit tab, select the web page where you want to modify HTML 
source. 

2 Place your mouse cursor in the line you want to edit and click the tag 
name. 

3 Click Tag Properties. 

The Tag properties dialog box opens. In this dialog box, you can change the following 
properties:  

 For TABLE (Table) tags, you can adjust cell spacing, cell padding, table width 
and height, table and cell alignment, and define the style of borders. 

 For TR (Table Row) tags, you can adjust row color and borders 

 For TD (Table Data) tags, you can change table text padding, margin, and 
decoration. 

 For A (Link) tags, you can change the link padding, margin, and decoration in 
the text. 

 For UL (Unordered List) and OL (Ordered List) tags, you can change the style of 
the list items. 

 For HR (Horizontal Rule) tags, you can adjust the colors and borders. 

 For IMG (Image) tags, you can adjust the colors and borders. 

4 Click OK. 

The changes will be immediately applied in the editor screen. 
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Working with Modules 

In Sitebuilder, there are two types of modules: 

 Page modules, or special pages. These modules are added to your site as 
separate web pages on the Pages step of Sitebuilder Wizard. There are the 
following special pages in Sitebuilder: 

 Blog (see page 48) 

 Image Gallery (see page 52) 

 File Download (see page 57) 

 eShop (see page 58) 

 Flash Intro (see page 67) 

 Guestbook (see page 68) 

 Forum (see page 70) 

 Registration (see page 73) 

All page modules available in Sitebuilder are described in Types of Pages (see page 25). 
For instructions on how to include special pages in your site structure, refer to 
Structuring Your Site (see page 26). 

 Block modules. These modules do not require dedicated site pages: they are 
inserted into ordinary text pages, and work as embedded functional blocks. There 
are the following block modules in Sitebuilder: 

 Area Map (see page 75). Allows you to include a map image of a certain 
location point into a web page. You can choose between two third-party GIS 
engines: Google Maps API and Microsoft MapPoint Web Service. 

 Feedback (see page 78). Allows you to include a feedback form into the page.   

 RSS Reader (see page 79). Allows you to automatically load favorite news and 
information to you site from RSS news feeds (also called "channels"). 

 Voting (see page 80). Allows to conduct polls and online surveys. 

 Script (see page 79). Allows you to add your own Java Script or HTML code to 
your web pages. 

Block modules are added and configured on the Edit step of the Sitebuilder Wizard. 

General rules for working with block modules are the following: 

 You can add any number of block modules to a page. 

 To insert a block module into a page, select the module icon in the Modules area on 
the right, click and drag it to the page where you want to insert the module. 

 Block modules cannot be viewed directly on the Edit step. You can only configure 
block modules there. To preview block modules as they are displayed on your site, 
click Preview. 

To delete a block module from the page, click  Remove Module on the block module 
dialog box. 
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For details on configuring each particular module, see the corresponding sections 
further in this guide. The links to appropriate pages are provided near the module 
names in the list above. 
 

Adding Blog 

A blog is a publicly accessible personal diary or journal, consisting of messages and 
comments. You can add a blog to your site and post you messages there. The visitors 
of your site can read your blog posts and give their comments. If you have lots of posts 
in you blog, you can subdivide them into categories for convenience. 

 To add a blog to your site: 

1 Go to the Pages step. 

2 Select  Blog in the Special pages box. 

3 Click .  

You can add several blogs to your site. 

 To set up your blog: 

1 Go to the Edit step. 

2 Select  Blog in the Site map area. 

 
 

Managing Posts in Your Blog 

After you add blog to your site, the next step is to fill it in with posts. The procedures of 
adding and managing your blog posts are described in the current section. 
 

Posting to Your Blog 

 To add a blog post: 

1 In the  Blog module, click the Content tab. 

2 Click  Add New Post. 

3 Enter a post subject in the Subject field. 

4 Enter post text in the Content field. 

5 If you want to add an image to the post, click the  Image manager 
icon, browse to an image file and click Upload. 

6 Click OK. 

At this stage, the list of categories is empty. After you add some categories (see page 
50), you can refer the created message to a desired category or several categories. 
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Editing Post 

 To edit an existing blog post: 

1 On the  Blog page, click the Content tab. 

2 On the Content tab, click the   Edit icon beside the post you want to 
edit. 

3 Edit the needed post parameters. 

4 Click OK. 

 
 

Removing Post 

 To remove a post from the blog: 

1 On the  Blog page, click the Content tab. 

2 On the Content tab, select the post you want to remove. 

3 Click  Remove Selected. 

 
 

Managing Comments on Blog Posts 

All your posted entries can be commented by your site visitors. You can edit and 
manage these comments, as well as add your own ones. The procedures of adding 
and managing your blog comments are described in the current section. 
 

Adding Comment 

 To add a comment: 

1 In the  Blog module, click the Content tab.  

2 Click View/Edit Comments beside the corresponding post. 

3 Click  Add New Comment.  

4 Enter a comment subject in the Subject field. 

5 Enter your name in the Posted by field. 

6 Enter the text of the comment in the Content field. 

7 Click OK. 
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Editing Comment 

As a blog owner, you can edit both your and your blog visitors comments. 

 To edit a comment: 

1 In the  Blog module, click the Content tab.  

2 Click View/Edit Comments beside the corresponding post. 

3 Click the  Edit icon beside the comment you want to edit. 

4 Configure the needed comment parameters. 

5 Click OK. 

 
 

Removing Comment 

 To remove a comment: 

1 In the  Blog module, click the Content tab.  

2 Click View/Edit Comments beside the corresponding post. 

3 Select the comment you want to remove. 

4 Click  Remove selected. 

 
 

Managing Categories of Blog Posts 

After you add some messages to your blog, you can sort them by subjects they 
discuss. These subjects are called categories. See the following sections to learn how 
to create and manage categories. 

Adding Category 

 To add a category: 

1 In the  Blog module, click the Categories tab. 

2 Click  Add New Category.  

3 On the Main Properties tab, enter a name of the new category in the 
Name field. 

4 From the Position in list list, select under which number the category 
should appear on the page. 

5 If you want to provide a short description of the category, click the 
Description tab and enter any text of your choice. 

6 Click OK. 
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Editing Category 

 To edit a category: 

1 In the  Blog module, click the Categories tab. 

2 On the Categories tab, click the  Edit icon beside the category you 
want to edit. 

3 Edit the needed category parameters. 

4 Click OK.  

 
 

Changing Order in which Categories are Listed on Page 

You can change the order in which categories appear in the Categories list by moving 
particular categories up and down in the list.  

To move a category up or down in the Categories list, click an upward  or a downward 
 arrow against the category name. One click on the icon moves the category one 

position up or down respectively. 

For categories which have reached the topmost or the bottom position of the list, the 
upward  or downward  arrows are not displayed, correspondingly. 
 

Removing Category 

 To remove a category: 

1 In the  Blog module, click the Categories tab. 

2 On the Categories tab, select a category you want to remove. 

3 Click  Remove Selected. 

Note: After a category is removed, all posts which have been assigned to it remain 
in the blog. 

 

Setting Up Blog Appearance 

 To set up the appearance of your blog: 

1 In the Blog module, click the Settings tab. 

2 Enter the number of posts to be displayed on one blog page in the  
Posts per page field. 

3 Enter the number of comments to be displayed on one blog page in 
the Comments per page field. 

4 Enter the maximum number of symbols a post summary can contain 
in the Post summary truncation limit field. 
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Adding Image Gallery 

The Image Gallery module allows you to place an image gallery or a photo album on 
your site in an easy and comfortable way. You can upload images, describe and 
categorize them, set the order of images, etc. 

 To add an image gallery to your site: 

1 Go to the Pages step. 

2 Select  Image Gallery in the Special pages dialog box. 

3 Click .  

You can add several image galleries to your site. 

 To set up your image gallery: 

1 Go to the Edit step. 

2 Select  Image Gallery in the Site map. 

 
 

Managing Images 

After you add image gallery to your site, the next step is to fill it in with images. The 
procedures of managing images are described in the current section. 
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Uploading Images 

 To upload one image at a time: 

1 In the  Image Gallery module, click  Image Upload on the Images tab. 

2 On the Main Properties tab, enter an image title in the Name field. 

3 From the Position in list list, select under which number the image 
should appear on the page. 

4 Click the Image tab. 

5 Click Browse, select an image file on your computer and click Open. 

6 Click Upload. The uploaded image is displayed in the Preview area of 
the Image tab. 

7 If you want to provide a short description of the image, click the 
Description tab and enter a text of your choice. 

8 Click OK. 

At this stage, the list of categories is empty. After you add some categories (see page 
55), they appear on the Categories tab and you can refer the image to a desired 
category or several categories. 

Sitebuilder provides a possibility of batch image upload, allowing to publish many 
images at once. You can upload the images from your local file system, and perform a 
group resize operation on them. The maximum size of the batch is determined by the 
disk space on the publishing server. 

 To upload multiple images: 

1 In the  Image Gallery module, click  Multiple Image Upload on the Images 
tab.  

Multiple image upload requires ActiveX Control to be installed in your browser. If 
the required component is missing from your browser, you will be prompted to 
install it. Follow the on-screen instructions to install the component. 

If you fail to install required components, click the If you do not see the Multiple Image 
Upload window, click here shortcut to open simplified image upload dialog where you 
can upload 10 images at once. 

If the required component is successfully installed, perform the following steps. 

2 In the left frame of the Add New Images window, navigate to the required 
folder in your local file system 

3 Select the images you want to upload.  

4 If you have already created a category for your images, then from the 
Upload to category list, select a category you want to refer the images to. 
If you have not created categories yet, select Create new category and 
type its name in the appeared field. 

5 If necessary, from the Resize large images to list, select the dimensions 
the uploaded images should be resized to. 

6 Click Upload.  



 

 Populating Site with Content 54 

 

7 After the upload is complete, click OK on the progress bar and on the 
screen. 

 
 

Previewing Images 

 To preview an image: 

1 In the  Image Gallery module, click the Images tab. 

2 Click the Preview icon against the image you want to preview. 

The image opens in a new window. 
 

Editing Image Properties 

 To edit an image: 

1 In the  Image Gallery module, click the Images tab. 

2 Click the  Edit icon against the image you want to edit. 

3 Configure the image parameters as desired. 

4 Click OK. 

 
 

Changing Order in which Images are Listed on Page 

You can change the order in which images appear on the site page by moving 
particular images up and down in the list.  

To move an image up or down in the list, click an upward  or a downward  arrow 
against the image name. One click on the icon moves the image one position up or 
down respectively. 

For images which have reached the topmost or the bottom position of the list, the 
upward  or downward  arrows are not displayed, correspondingly. 
 

Removing Image 

 To remove an image: 

1 In the  Image Gallery module, click the Images tab. 

2 Select the image you want to remove. 

3 Click  Remove Selected.  
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Managing Categories of Images 

You can use image categories to better organize your images. An image category is a 
group of images in the gallery, which have something in common. One image may 
belong to one or several categories at the same time. It is especially convenient to split 
images into categories, when the number of images is big. See the following sections 
to learn how to create and manage categories. 

Adding Category 

 To add a category: 

1 In the  Image Gallery Module, click the Categories tab.  

2 Click  Add New Category. 

3 On the Main Properties tab, enter a name of the new category in the 
Name field. 

4 From the Position in list list, select under which number the category 
should appear on the page. 

5 If you want to add an image that will be displayed beside the category 
name, click the Image tab. 

6 Click Browse, select an image file on your computer and click Open. 

7 Click Upload. 

The uploaded image is displayed in the Preview area. 

8 If you want to provide a short description of the category, click the 
Description tab and enter a text of your choice. 

9 Click OK. 

 
 

Editing Category 

 To edit a category: 

1 In the  Image Gallery module, click the Categories tab. 

2 Click the  Edit icon beside the category you want to edit. 

3 Configure the needed category parameters. 

4 Click OK. 
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Changing Order in which Categories are Listed on Page 

You can change the order in which categories appear in the Categories list by moving 
particular categories up and down in the list.  

To move a category up or down in the Categories list, click an upward  or a downward 
 arrow against the category name. One click on the icon moves the category one 

position up or down respectively. 

For categories which have reached the topmost or the bottom position of the list, the 
upward  or downward  arrows are not displayed, correspondingly. 
 

Removing Category 

 To remove a category: 

1 In the  Image Gallery module, click the Categories tab. 

2 Select the category you want to remove. 

3 Click  Remove Selected.  

 
 

Setting Up Image Gallery Appearance 

 To set up image gallery appearance: 

1 In the  Image Gallery module, click the Settings tab. 

2 In the Images per page field, enter a number of images to be displayed 
on one page. 
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Providing Content for Download 

The File Download module allows to provide various content for download to your site 
visitors. The file format is arbitrary; the maximum size of the file is determined by 
parameters of your network. 

 To add the File Download module to your site: 

1 On the Pages step, select  File Download in the Special pages box. 

2 Click .  

You can place only one file on the File Download page. If you wish to provide several 
files for download, add as many File Download pages to your site map as necessary. In 
this case, we recommend creating all File Download pages as second level pages and 
attaching them to one top level page. 

 To upload a file that will be available for downloading: 

1 On the Edit step, select  File Download in the Site map area. 

2 Click Browse,  select a file and click Open. 

3 Click Upload. 

4 Specify a name for the file in the  File name box. Under this name the 
file will be displayed to site visitors. By default, it is the original name 
of the uploaded file. 

Note: National characters in file extensions are not supported. If your file extension 
contains national characters, replace them with Latin characters, or append a dot (.) 
at the end of the string to make these characters a part of the file name. 

In the upper part of the screen you will see the results of the operation and the file 
size. 

To replace the uploaded file, click Browse once again and select another file. 

To ensure that the provided setup works correctly, you can perform a test download of 
the file. To do so, click the Download shortcut. 
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Adding Online Store 

In Sitebuilder, you can set up your own online store by adding the eShop module into 
your site. You, as an e-shop owner, can add products and categories, sort products by 
categories, and manage orders submitted by the customers. Your customers can 
browse your online store, add products to their shopping carts, select their preferred 
payment systems and shipping methods, and submit their orders. After the first 
purchase, they can return to their shopping carts any time and continue shopping. Your 
e-commerce resource can be integrated with PayPal, Authorize.Net, BluePay, and 
2CheckOut.com payment systems, so that customers could pay for their purchases 
using their credit cards.  

 To add an online store to your site: 

1 Go to the Pages step. 

2 Select  eShop in the Special pages box. 

3 Click . 

You can set up several online stores on your site by adding as many eShop page 
modules to your site structure as necessary. In this case, the currency, payment 
settings, lists of categories and products you create in different eShop modules are 
independent of each other.  

 To set up your online store: 

1 Go to the Edit step. 

2 Select  eShop in the Site map. 

 
 

Managing Products 

After you add the eShop module to your site, the next step is to populate it with 
products. The procedures of adding and managing products are described in the 
current section. 
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Adding Products to Catalogue 

 To add a new product: 

1 On the  eShop page, click  Add New Product on the Products tab. 

2 On the Main Properties tab, specify the general product properties: 

 Name, under which the product is displayed in the catalogue 

 Price, which is displayed in the catalogue in the currency and format you select 
on the Payment Systems tab of eShop module editor 

 Position in list, which is the index number under which the product is displayed in 
the catalogue 

3 If you do not wish to sell this product, just to display information about 
it, select the Advertise only check box. 

Your eShop buyers won't be able to add this product to their carts. 

4 If you want to add an image that will be displayed beside the product 
name, go to the Image tab, browse to an image file on your computer 
and click Upload. 

Note: Later you can preview this image on the Products tab by clicking the   icon 
for the product in the P (Preview) column. For products for which no image has been 
uploaded, this icon is not displayed in the list.  

5 If you want to add a short description of your product, go to the 
Description tab and type your text in the text box. 

6 Click OK. 

At this stage, the list of categories is empty. After you add some categories (see page 
60), you can refer the created product to a desired category. 

To preview products in your online store, click Preview at the bottom of the Sitebuilder 
window and go to the online store page of your web site. 

Editing Product Properties 

 To edit the properties of a product: 

1 On the  eShop page, click the Products tab. 

2 Click the  Edit icon beside the product you want to edit. 

3 Configure the needed product parameters. 

4 Click OK. 
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Changing Order in which Products are Listed in Catalogue 

You can change the order in which images appear on the site page by moving 
particular images up and down in the list.  

To move an image up or down in the list, click an upward  or a downward  arrow 
against the image name. One click on the icon moves the image one position up or 
down respectively. 

For images which have reached the topmost or the bottom position of the list, the 
upward  or downward  arrows are not displayed, correspondingly. 
 

Removing Product 

 To remove a product from your online store: 

1 On the  eShop page, go to the Products tab. 

2 Select the product you want to remove. 

3 Click  Remove Selected. 

 
 

Managing Categories of Products 

After you add a number of products to your e-shop, you may need to sort them by 
categories, so that your customers could easily navigate in your catalogue. The 
procedures of adding and managing product categories are described in the current 
section. 
 

Adding Category to Catalogue 

 To add a product category: 

1 On the  eShop page, click the Categories tab. 

2 Click  Add New Category. 

3 On the Main Properties tab, enter a name of the new category in the 
Name field. 

4 From the Position in list list, select the index number under which the 
category will be displayed in the catalogue. 

5 If you want to add an image that will be displayed beside the category 
name, go to the Image tab, browse to an image file and click Upload.  

Note: Later you can preview this image on the Categories tab by clicking the   
icon for the product in the P (Preview) column. For categories for which no image has 
been uploaded, this icon is not displayed. 

6 If you want to provide a short description for the category, click the 
Description tab and enter a text of your choice. 

7 Click OK. 
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Editing Category 

 To edit an existing category 

1 On the  eShop page, click the Categories tab.  

2 Click the  Edit icon next to the desired category name. 

3 Edit the category properties as desired. 

4 Click OK. 

 
 

Changing Order in which Categories are Listed in Catalogue 

You can change the order in which categories appear in the Categories list by moving 
particular categories up and down in the list. 

To move a category up or down in the Categories list, click an upward  or a downward 
 arrow against the category name.  

One click on the icon moves the category one position up or down respectively. 

For categories occupying the topmost or the bottom position of the list, the upward  
or downward  arrows are not displayed, correspondingly. 
 

Removing Category 

 To remove a category: 

1 On the  eShop page, click the Categories tab.  

2 Select a category you want to remove. 

3 Click  Remove Selected. 

Note: When a category is removed, the products belonging to this category remain in 
your catalogue. These products are displayed in the uncategorized list, unless they 
have been assigned to other categories as well. 
 

Configuring Payment Settings for Your Online Store 

You can configure the following payment settings for your online store: 

 currency and price format 

 payment systems and shipping methods 

 
 

Selecting Currency 

 To select a currency to be used in your online store: 

1 In the  eShop module editor, go to the Payment Systems tab. 

2 From the Currency list, select a desired currency. 

When selecting currency, make sure it is supported by all payment systems you 
wish to integrate into your online store. 
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Configuring Payment System Settings 

In Sitebuilder, you can offer your customers the following payment options. 

 Offline payment options: 

 Cash on delivery. Payment is made, when product is delivered to a customer. 

 Check/Money order. Customer issues check or money order that will be sent to 
you by regular mail. 

 Online payment options: 

 PayPal. Customer pays you for the product online using PayPal payment system.  

 Authorize.Net. Customer pays you for the product online using Authorize.Net 
payment system. 

 BluePay. Customer pays you for the product online using BluePay payment 
system. 

 2Checkout.com. Customer pays you for the product online using 2Checkout.com 
payment system. 

This is the default list of available payment systems. Sitebuilder administrator can 
disable some of the payment systems and integrate a custom payment system to the 
eShop module.  

To use all these payment options, you need to configure them in your eShop. The only 
exception is the Cash on Delivery option, which does not require you to provide any 
details: you can only activate or deactivate it in your online store. 

To accept payments online, you should integrate the PayPal, Authorize.Net, BluePay, 
and 2Checkout.com payment gateways into your online store. To do so, you should 
register merchant or vendor accounts with these systems. For more details about 
signing up to these payment systems, visit the PayPal (https://www.paypal.com/), 
Authorize.Net (http://www.authorize.net/), BluePay (http://bluepay.com/), and 
2Checkout.com, Inc (http://www.2checkout.com). official web sites. 

Note: Before registering with online payment systems, refer to their web sites and 

make sure that the currency you chose for your online store is supported.  
 

Configuring Check/Money Order Payment Method 

 To customize check/money order settings: 

1 In the  eShop module, click the Payment Systems tab. 

2 Select the check box beside the Check / Money order payment option. 

3 In the Make payable to field, enter the name of person, to whom funds 
should be sent. 

4 In the Send to address field, enter the postal address, where the check 
or order should be sent. 

 
 

https://www.paypal.com/
http://www.authorize.net/
http://bluepay.com/
http://www.2checkout.com/
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Configuring Authorize.Net Integration 

Authorize.Net allows your customers to pay for your products online using credit cards 
or electronic checks. 

 To integrate Authorize.Net payment system in your online store: 

1 In the  eShop module, click the Payment Systems tab. 

2 Select the check box beside the Authorize.Net payment system. 

3 In the Login field, enter the login you use to log in to Authorize.Net. 

4 In the Transaction key field, enter the transaction key used for encrypting 
data. 

Note: Requests to Authorize.Net server are executed only on published sites. If you 
open your site in the preview mode, you can see the corresponding window, but the 
request to Authorize.Net server is not executed. 
 

Configuring PayPal Integration 

 To configure the PayPal payment system for your online store: 

1 In the  eShop module, click the Payment Systems tab. 

2 Select the check box beside the PayPal payment system. 

3 In the E-mail address field, enter the e-mail address you use to log in to 
the PayPal service. 

Note: Requests to PayPal server are executed only on published sites. If you open 
your site in the preview mode, you can see the corresponding window, but the request 
to PayPal server is not executed. 
 

Configuring BluePay Integration 

 To configure the BluePay payment system for your online store: 

1 In the  eShop module, click the Payment Systems tab. 

2 Select the check box beside the BluePay payment system. 

3 In the Merchant ID and Secret key fields, provide the corresponding data 
which you received from BluePay. 

Note: Requests to BluePay server are executed only on published sites. If you open 
your site in the preview mode, you can see the corresponding window, but the request 
to BluePay server is not executed. 
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Configuring 2Checkout.com Integration 

 To configure the 2Checkout.com payment system for your online store: 

1 In the  eShop module, click the Payment Systems tab. 

2 Select the check box beside the 2Checkout.com payment system. 

3 In the Vendor account number field, enter the login/user name you use to 
log in to 2Checkout.com. 

Note: Requests to the 2Checkout.com server are executed only on published sites. If 
you open your site in the preview mode, you can see the corresponding window, but 
the request to 2Checkout.com server is not executed. 
 

Adding Shipping Methods and Specifying Shipping Costs 

Sitebuilder allows you to add a shipping cost to the order total in your online store. You 
can specify a separate shipping cost for each available delivery method or 
geographical area. 

When placing an order in your online store, the customer chooses a shipping method 
(a required option), and the cost associated with the method is added to the order total. 

 To add a shipping method: 

1 In the  eShop module, click the Shipping Methods tab. 

2 On the Shipping Methods tab, click Add New Shipping Method. 

3 On the Main Properties tab: 

1. Specify the method name in the Shipping method field. 

2. Enter the delivery cost in the Shipping cost field. 

3. From the Position in list list, select under which index number the 
method should be displayed in the list.  

4 If you want to provide a short description of the method, go to the 
Description tab, type your text. 

5 Click OK. 
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Managing Customers' Orders 

Orders management becomes available after you publish your site. You can manage 
the orders only from your Administrator Panel.  

To proceed to orders management, go to the Orders tab in the eShop module and click 

 Go to Orders List. 

 To change order status: 

1 Click the  Edit icon beside an order.  

2 From the Status list, select a new status for the order. 

 E-shop orders can have the following statuses:  

 New. The status is used for new unpaid orders. 

 Paid. The status is used for new paid orders. This status is assigned to an order 
upon receiving the payment notification from a payment system. 

 Processed. The status is used for orders being processed at the time. 

 Backorder. The status is used for deferred orders. 

 Completed. The status is used for orders which have been completed and 
delivered to the customers. 

 Cancelled. The status is used for order canceled by the customers. 

 Failed. The status is used for orders which cannot be processed for some 
reason. 

3 Click OK. 

To filter the orders by status, use the Status list. 

To filter the orders by time period, use the Time period list. 

To delete an order, select it and click Delete. 

If you have several online stores on your site, then use the E-shop name list to switch 
between them. 
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Setting Up Online Store Appearance 

 To set up the appearance of your online store: 

1 In the  eShop module, click the Settings tab. 

2 In the Notification sender's e-mail address field, specify the e-mail address 
to be displayed in the "From" field of order confirmations sent to your 
customers. 

3 In the Number of columns on Categories page field, specify the number of 
columns of categories to be displayed on one page. 

4 Select a parameter the products list will be sorted by from the Sort field 
on Products page list.  

5 Set the order the products will be sorted in by selecting the Ascending 
or Descending option. 

6 In the Number of Products field, specify how many products should be 
displayed per page 
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Adding Flash Intro 

A flash intro is the flash-animated introduction clip launched prior to opening the home 
page of a site. You can choose between several designs of the intro and insert your 
own text information into it. 

Note: 1. The Flash Intro module is the only page module that requires no database 
connection and therefore can be included in a static site. 

2. For correct display of Asian and Arabian national characters, make sure that you 
have Adobe Flash Player version 9.0 or later installed.  

 To add flash intro to your site: 

1 Go to the Pages step. 

2 Select  Flash Intro in the Special pages box. 

3 Click .  

 To configure the flash intro settings: 

1 Go to the Edit step. 

2 Select  Flash Intro in the Site map area. 

3 Select a design of your flash clip by clicking one of the thumbnails in 
the Designs area. 

The selected design is outlined with a red frame. 

4 In Header text field, enter a text to be displayed as the flash introduction 
title. 

5 In the Body text field, enter a text to be displayed as the body of the 
flash clip. 

6 From the Background scheme list, select a background color of the flash 
clip.  

7 From the Object scheme field, select a color of your flash clip outline. 

You can see the small preview image of the flash clip with the new parameters in the 
Preview area. 
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Adding Guestbook 

Guestbook enables your visitors to leave their notes, messages, and comments. The 
main difference between guestbooks and online forums is that in forums, all messages 
are grouped in threads, or topics. In guestbooks, all messages are displayed as they 
were submitted in the reverse order (new messages appearing on the top). 

 To add a guestbook to your site: 

1 Go to the Pages step. 

2 Select  Guestbook in the Special pages box. 

3 Click .  

You can add several guestbooks to your site. 

 To set up your guestbook: 

1 Go to the Edit step. 

2 Select  Guestbook in the Site map. 

 
 

Managing Guestbook Messages 

After you add the guestbook to your site, you can try it and post a new message. The 
procedures of managing guestbook messages are described in the current section. 
 

Adding Message to Your Guestbook 

 To add a message: 

1 On the  Guestbook page, click the Content tab. 

2 Click  Add New Message. 

3 Enter a message text. 

4 Click OK. 
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Editing Message 

 To edit a message: 

1 In the  Guestbook module, click the Content tab. 

2 Click the  Edit icon beside the message you want to edit. 

3 Edit the message. 

4 Click OK. 

 
 

Removing Message 

 To remove a message: 

1 On the  Guestbook page, click the Content tab. 

2 Select the message you want to remove. 

3 Click  Remove Selected. 

 
 

Setting Up Guestbook Appearance 

 To set up the appearance of your  guestbook: 

1 In the  Guestbook module, click the Settings tab. 

2 In the Message lifetime field, enter the number of days after which the 
messages will be added to archive. Whether a message is or is not 
archived is shown in the S column on the Content tab. 

3 In the Number of messages per page field, enter a number of messages to 
be displayed on one guestbook page.  

4 If you want the e-mails of messages' authors to be displayed to the 
guestbook visitors, select the Show author's e-mail check box. 
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Adding Forum 

Online forums are web-based message boards where visitors can open new topics, 
post topic-relevant messages, and discuss a wide range of questions. 

 To add a forum to your site: 

1 Go to the Pages step. 

2 Select  Forum in the Special pages box. 

3 Click .  

You can add several forums to your site. 

 To set up your forum: 

1 Go to the Edit step. 

2 Click  Forum in the Site map. 

 
 

Managing Forum Topics 

After you add forum to your site, you can try it and post a new topic. The procedures of 
managing forum topics are described in the current section. 
 

Adding Topic to Your Forum 

 To add a topic: 

1 On the  Forum page, click the Content tab. 

2 Click  Add New Topic. 

3 On the Main Properties tab, enter a subject of the new topic. 

4 Click the Content tab. 

5 Enter your text. 

6 Click OK. 

At this stage, the list of categories is empty. After you add some categories (see page 
72), they appear on the Categories tab and you can refer the topic to one of them. 

Note: If you do not refer a topic to any category, this topic will not be displayed in your 
forum. 
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Editing Topic 

 To edit a topic: 

1 In the  Forum module, click the Content tab. 

2 Click the  Edit icon beside the topic you want to edit. 

3 Configure the needed topic parameters. 

4 Click OK. 

 
 

Removing Topic 

 To remove a topic: 

1 In the  Forum module, click the Content tab. 

2 Select the topic you want to remove. 

3 Click  Remove Selected. 

 
 

Managing Replies to Topics 

After some topics were added to your forum, you and your site visitors can add replies 
to those topics. You can edit and manage both your and your site visitors' replies. The 
procedures of managing replies to topics are described in the current section. 
 

Adding Reply 

 To add a reply: 

1 In the  Forum module, go to the Content tab. 

2 Click the subject of the topic, to which you want to add a reply.  

3 Click  Add New Reply. 

4 Enter reply text. 

5 Click OK. 

 
 

Editing Reply 

 To edit a reply: 

1 In the  Forum module, go to the Content tab. 

2 Click View/Edit Replies against the respective topic. 

3 Click the  Edit icon beside the reply you want to edit. 

4 Edit the reply text. 

5 Click OK. 
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Removing Reply 

 To edit a reply: 

1 In the  Forum module, go to the Content tab. 

2 Click View/Edit Replies beside the corresponding topic. 

3 Select a reply and click  Remove Selected. 

 
 

Managing Categories of Forum Topics 

You can sort the topics in your forum by subjects they discuss. These subjects are 
called categories. The procedures of adding and managing categories are described in 
the current section. 
 

Adding Category 

 To add a category: 

1 In the  Forum page, click the Categories tab. 

2 Click  Add New Category. 

3 Enter a name of the new category in the Name field. 

4 If you want to provide a short description of the category, click the 
Description tab and enter a text of your choice. 

5 Click OK. 

 
 

Editing Category 

 To edit a category: 

1 In the  Forum module, click the Categories tab. 

2 On the Categories tab, click the  Edit icon beside the category you 
want to edit. 

3 Configure the needed category parameters. 

4 Click OK. 

 
 

Removing Category 

 To remove a category: 

1 In the  Forum module, click the Categories tab. 

2 On the Categories tab, select the forum category you want to remove. 

3 Click  Remove Selected. 
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Setting Up Forum Appearance 

 To set up the appearance of your forum: 

1 In the  Forum module, click the Settings tab. 

2 Enter a maximum number of categories per page. 

3 Enter a maximum number of topics per page. 

4 Enter a maximum number of replies per page. 

5 Enter a maximum number of search results per page. 

 
 

Providing Registration for Your Site Visitors 

You can set up voluntary user registration on your web site. This function has nothing 
to do with restricted access. Registered users don't have to enter their name, address, 
and other data each time they fill a form in the system - this data is automatically 
inserted into the appropriate text fields of the form (for example, when posting to blog 
or buying in e-shop). 

 To enable registration on your site: 

1 Go to the Pages step. 

2 Select  Registration in the Special pages box. 

3 Click .  

 To set up registration settings: 

1 Go to the Edit step. 

2 Select  Registration in the Site map. 

3 To enable or disable registration, select or clear the corresponding 
check box in the Registration section. 

4 To enable or disable password recovery option, select the 
corresponding check box in the Password recovery section. 
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Managing Registered Site Visitors 

After your site is published, you can manage your registered site users through the 
Sitebuilder Administrator Panel.  

 To proceed to managing registered site visitors: 

1 Proceed to your Administrator Panel by clicking  Go to Admin Panel at 
the top of the screen. 

2 On the navigation pane, click  Sites. 

3 Click your site in the list of sites. 

4 Click  Site Users. 

 
 

Adding Site Visitor Account 

If you want to control the number of registered visitors on a site, you can register them 
yourself and then provide them with credentials for accessing the site. 

 To add a site visitor account: 

1 On the  Site Users screen, click  Add New Account. 

2 Specify the contact and login information. 

3 If necessary, in the Home page URL field, specify the URL to the site 
visitor's home page. This URL will be automatically inserted to the 
messages posted by this site visitor to the guestbook. 

4 Click OK. 

 
 

Changing Site Visitor Account Information 

You may need to modify site visitor accounts if, for example, a site visitor forgets his or 
her password or specifies wrong e-mail. 

 To modify a site visitor account: 

1 On the Site Users screen, click the name of the site visitor whose 
account you want to modify. 

2 Make necessary changes. 

3 Click OK. 
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Suspending and Unsuspending Site Visitor Account 

By default, all created site visitor accounts are active. If an account is active, the site 
visitor can access this site by entering their login and password. If, due to some 
reasons, you want to prohibit a site visitor from accessing a site, you can suspend their 
account.  

 To suspend a site visitor account: 

1 On the Site Users screen, select the site visitor account you want to 
suspend. 

2 Click Deactivate. 

Suspended site visitor accounts are indicated with the  sign. 

 To unsuspend a site visitor account: 

1 On the Site Users screen, select the site visitor account you want to 
unsuspend. 

2 Click Activate. 

Unsuspended site visitor accounts are indicated with the  sign. 
 

Adding Maps 

You can add maps to your site, thus displaying any location that may be of interest to 
your site visitors. 

To add geographical maps to your site, you can either use the free-of-charge Google 
Maps service (see page 76), or purchase the Microsoft MapPoint Web Service (see 
page 77) from Microsoft, Inc. 
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Configuring Google Maps API Service 

The Google Maps API service lets you embed Google Maps in your own web pages. 
You can add overlays to the map (including markers and polylines) and display 
shadowed "info windows" just like Google Maps. The Google Maps API service is 
provided free of charge. 

The Google Maps API service supports the following browsers: 

 Internet Explorer 6.0 and later 

 Firefox 0.8 and later 

 Safari 1.2.4 and later 

 Netscape 7.1 and later 

 Mozilla 1.4 and later 

 To embed a Google Maps API module into your web page: 

1 Go to the Edit step. 

2 In the Modules area, click the  Area Map module icon and keeping the 
left mouse button pressed drag the icon to the page. 

3 Click Select Provider. 

4 Select Google Maps API. 

5 Enter your registration key in the Google Maps API key box and click OK.  

If you haven't registered this service with Google yet, click the provided link to go to 
the Google Web site and complete the free sign up procedure as described. When 
registering a Google Maps API key, be sure to specify the correct URL of your site. 

Note: If you get an error message saying that the key you have specified was 
generated for another URL, enter your web site URL in the Web site URL field to fix 
the problem. 

6 Back to the Area Map module, click Choose Location. 

7 Type the name of the geographical location you want to show and 
click Find Locations. 

If for some reason Google doesn't find the required location, or if you want to 
specify your own location, use the arrows and scaling functions to manually 
navigate to the required geographical point.  

8 Click on the required point on the map. On the form that appears, 
specify the title and address of the location in the Title and Address 
fields and click Save. 

9 Click OK. 

On the site page, the specified location is marked with the red icon. The title and 
address of the location is displayed after you click on the icon. 
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Configuring Microsoft MapPoint Web Service 

In order to use the Microsoft MapPoint Web Service on your pages, you first need to 
purchase this service from Microsoft, Inc.  

You can choose one of licensing options provided by Microsoft, Inc.: 

 Purchase MapPoint Web Service through a direct agreement with Microsoft. If you 
choose this method, you purchase one license per each Area Map module, added to 
your sites.  

 Purchase MapPoint Web Service through Microsoft Volume Licensing. If you 
choose this method, you purchase one license for all Area Map modules, added to all 
your sites.  

 To embed a Microsoft MapPoint Web Service map into your web page: 

1 Go to the Edit step. 

2 In the Modules area, click the  Area Map module icon and keeping the 
left mouse button pressed drag the icon to the page. 

3 Click Select Provider. 

4 Select Microsoft MapPoint. 

5 Enter your Microsoft MapPoint Service credentials in the User name and 
Password fields and click OK. 

If you have not yet purchased a Microsoft MapPoint Service license, click the 
provided link to go to the  Microsoft MapPoint Service page and follow the 
instructions on purchasing the Microsoft MapPoint Service. 

6 Enter the name of the location you want to show in the Find Locations 
field. 

7 Click Find Locations. 

8 From the list of results, select the location to be displayed on your 
web page. 

9 Click OK. 

Note: If later you change your Microsoft MapPoint Service account settings, click Relog 
in to MS Map. You will be forwarded to the Area Map configuration window, where you can 
enter your new credentials. 
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Adding Feedback Form 

Online feedback forms enables you to gather information about your site visitors. 

 To set up a feedback form on your site: 

1 Go to the Edit step. 

2 In the Modules area, click the  Feedback module icon and keeping the 
left mouse button pressed drag the icon to the page. 

3 To arrange the list of fields in your feedback form, click Add/Edit Fields. 

By default, the Feedback module contains a number of fields commonly used in 
feedback forms. You can adjust the existing fields, as well as add new ones by 
clicking Add Field. 

4 In the Name field, type a name for the field. 

5 From the Type field, select the type of data that can be entered in 
current field: 

 String - for entering text of maximum 255 symbols without line breaks. The text 
can include letters of national alphabets, punctuation marks, special symbols. 

 Text - for entering text of maximum 1500 symbols. The text can include line 
breaks, letters of national alphabets, punctuation marks, special symbols. On 
the published site the text is displayed in the multiline mode. 

 E-mail - for entering e-mail addresses. 

 Double - for entering floating-point numbers. A comma or a point can be used as 
a decimal separator. 

 Integer - for entering integer numbers. 

 Date - for entering dates. 

 Phone - for is the type of field where you can enter an international phone 
number. 

6 To make a field required for filling in, select the Required check box 
beside the corresponding field. 

7 Set the order of fields in the feedback form by clicking  or  beside 
the fields you need to move. 

8 To remove a field, select the field you want to remove and click . 

9 To specify the text to be displayed to the site visitors after they submit 
the feedback form, click Response Text and provide your text. 

10 To set up the general properties of your feedback form, click Properties 
and: 

 In the Title field, enter a display name of the feedback form.  

 In the E-mail field, enter the e-mail address the filled in feedback forms will be 
sent to. 

 In the Subject field, enter the subject of the feedback e-mails. 

11 Click OK. 
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Adding RSS News Feeds 

RSS, which stands for Really Simple Syndication, allows you to automatically load 
favorite news and information on you site from RSS news feeds (also called 
"channels"). Many well-known news communities and corporate sites offer news 
headlines and article summaries in the form of news channels. RSS readers retrieve 
the recent content from the RSS news feeds and display it on your site. A visitor can 
preview the recent news content from your site and will be redirected to the news page 
if they want to read the full story. The news from RSS channels are updated 
automatically and do not require any interaction from your part.  

 To add RSS news feeds to your site: 

1 Go to the Edit step. 

2 In the Modules area, click the  RSS Reader module icon and keeping 
the left mouse button pressed drag the icon to the page. 

3 Click Change Channel and select one of the proposed channels. 

4 To specify a custom channel, click Custom channel and enter the 
channel URL in the field below. 

5 Click OK. 

 
 

Inserting Scripts to Your Web Pages 

Using the Sitebuilder Wizard, you can add your own Java Script, HTML, and DHTML 
code to your web pages. 

 To insert a piece of code to your site: 

1 In the Modules area, click the  Script module icon and keeping the left 
mouse button pressed drag the icon to the page. 

2 Click Change Script Source and enter your code. 

3 Click OK. 

 
 



 

 Populating Site with Content 80 

 

Conducting Polls and Online Surveys 

Online polls and surveys enable you to receive valuable feedback from your site 
visitors. You can collect votes on different questions and display the results as dynamic 
graphical charts directly on the page. The Sitebuilder voting module tracks visitor 
uniqueness based on the single session principle, that is a visitor cannot vote several 
times in this poll within the same session. 

 To set up voting on your site: 

1 Go to the Edit step. 

2 In the Modules area, click the  Voting module icon and keeping the left 
mouse button pressed drag the icon to the page. 

3 To provide the question of your survey, click Change Question and type 
your question. 

4 To arrange the list of available answers, click Change Answers. 

5 To add an answer, click Add New Answer.  

6 Enter an answer variant in the newly appeared field. 

7 To change the order of answers in the voting form, use  and  
arrows. 

8 To delete an answer, select an answer and click .  

9 Click OK. 
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Publishing your site as an anonymous user 

If you do not have a Sitebuilder account and work with the program in demo mode, the 
site you create is temporary and cannot be published on the Internet until you buy 
hosting. After you click Publish, you will be provided with the information about your site 
and with the instructions about how you can publish it. To keep this information, you 
can send it to your e-mail. The e-mail will include the following information: 

 The life-time of your trial site, i.e. the period of time it will be stored on the 
Sitebuilder server. 

 The site preview link. The link to your site as it is displayed to the visitors. You may 
send this link to your friends, for example. 

 The link to your temporary site in editable mode. This link opens your site in 
Sitebuilder Wizard. You will need this link, if you decide to register in Sitebuilder 
and make your temporary site regular. 

 Any supplementary information considered to be important by the Sitebuilder 
administrator, for example, instructions on how you can get an account in 
Sitebuilder and buy hosting. 

To open the trial site, click Visit Site. The site is fully functional, and allows you to 
perform all operations allowed by modules, except for placing orders in your online 
store. The site is active during its life-time period, which is determined by your 
Sitebuilder administrator. 

Publishing your site as a regular Sitebuilder user 

If you are a registered Sitebuilder user, follow the guideline below to publish your site. 

 To publish your site: 

1 Go to the Publish step. 

2 If your Sitebuilder administrator has already specified the publishing 
settings for your site (or you have done it yourself in your 
Administrator Panel), then just click Publish and publication begins. If 
publishing settings are not specified, perform steps 3-8. 

3 Click Edit publishing settings. 

Sitebuilder administrator can prohibit users from editing publishing settings. In that 
case publishing settings will be displayed to you in read-only mode. 

4 Select a publishing mode (the list of available publishing modes is 
configured by your Sitebuilder administrator):  

 FTP - publishing site to an FTP server.  

 VPS - publishing site to a virtual private server. 

 XCopy - publishing site using the XCOPY technology. 

C H A P T E R  7  

Publishing Site 
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5 If you select FTP publishing mode, provide the following parameters: 

 Host is the IP address or domain name of the FTP server.  

 If the maximum number of hosts allowed by your plan is limited, select a host 
from the list. This list consists of hosts included in your service plan. 

 If the number of hosts allowed by your plan is unlimited, you can specify any 
FTP server you have at your disposal (make sure that the server meets the 
requirements (see page 83)). 

 Port is the port for connecting to the specified FTP server. 

 Web site URL is the address the site will be available at after publication. 

 Working directory is the path on your FTP server to the folder where the site files 
will be stored after publication. 

 If the FTP server is password protected, specify the access credentials in the 
Login and Password fields. 

6 If you select XCOPY publication mode, provide the following 
parameters: 

 Host is an IP address, domain name, or machine name of the publishing server. 

 Web site URL is the address the site will be available at after publication. 

 Working directory is a name of the share on the server and the path to the files of 
your site. Do not include the name of the server into this path. For example, 
Sitebuilder\Site1 

7 If you select VPS publication mode, provide the following parameters: 

 Physical server is an IP address, domain name, or machine name of the 
computer running a virtual server. 

 Port is a port for connecting to the specified virtual server. 

 VPS identifier is an integer number of a virtual server identifying it on the physical 
server. 

 Web site URL is the address the site will be available at after publication. 

 Working directory is the absolute path on the virtual server to the folder where the 
site files will be stored after publication. 

 If the server is password protected, specify the access credentials in the Login 
and Password fields. 

8 Click Publish. The progress bar displaying the status of publication 
appears. 

After successful publishing, your site immediately goes live, and its full functionality 
is available to visitors. You can proceed to your site by clicking Visit Site. 

If next time you come to publish your site, you'll find that the publishing settings have 
been changed since the last publication, you can revert them to their previous state. To 
do so, click Revert Publishing Settings at the bottom of the form with the publishing 
setting. 

In this chapter: 

Requirements to Publishing Location ................................................................ 83 
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Requirements to Publishing Location 

For the published sites to work correctly, publishing server must meet the following 
requirements: 

 ASP.NET 2.0.50727 or later is installed on the publishing server. 

For detailed information about configuring ASP.NET 2.0, refer to the ASP.NET 2.0 
Deployment Guide 
(http://www.microsoft.com/downloads/details.aspx?familyid=9E33EA25-666C-
47FA-AC52-8D04785C4BD2&displaylang=en). 

 The working directory is mapped on the IIS server as web application. 

 For the ASP.NET ISAPI to be executed, the working directory must have the 

Scripting permission enabled (working directory menu > Execute Permissions > 

Scripts Only). 

 Application pool to which the working directory is assigned does not contain 
ASP.NET 1.1 applications. 

 ASP.NET account has the following permissions: 

 If the App_Data folder does not exist, read/write/delete permission for the root 

folder is required. 

 If the App_Data folder exists, then read/write/delete permission for the 

App_Data folder and read permission for the root folder are required. 

Note: 1. If you use IIS 5.0, the above permissions should be given to the 
identity specified in 
/configuration/system.web/deployment/processModel/@userN

ame of the 
%WINDIR%\Microsoft.NET\Framework\v2.0.50727\CONFIG\machi

ne.config file. 

2. If you use IIS 6.0, the above permissions should be given to the application 
pool identity specified in IIS settings (Start>IIS Manager>Application 
Pools>respective application pool> Properties>Identity tab). 

 IIS application pool identity (NETWORK SERVICE by default) must have 

permission to create files and folders in the %WINDIR%\temp folder. 

 The order in which the default documents (default.htm, default.aspx, and so on) will 
be used to respond the browser request is defined (working directory menu > 
Properties > Documents tab).  

 Publishing server works in the Medium Trust mode at least. If a server works in the 

Medium Trust mode, it must be granted with OleDbPermission for accessing 

Microsoft Access database and with WebPermission for the RSS module to work 

correctly. 

 OleDbPermission is set in the web_mediumtrust.config file, stored on 

the publishing server. By default, this permission is disabled. To grant this 

permission, you should add the OleDbPermission class to the following 

sections of the web_mediumtrust.config file: 

 SecurityClasses  

http://www.microsoft.com/downloads/details.aspx?familyid=9E33EA25-666C-47FA-AC52-8D04785C4BD2&displaylang=en
http://www.microsoft.com/downloads/details.aspx?familyid=9E33EA25-666C-47FA-AC52-8D04785C4BD2&displaylang=en
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Example: 

      <SecurityClass Name="OleDbPermission" 

      Description="System.Data.OleDb.OleDbPermission, 

System.Data, Version=2.0.0.0,  

             Culture=neutral, 

PublicKeyToken=b77a5c561934e089"/>  

  PermissionSet  

Example: 

      <IPermission class="OleDbPermission" version="1" 
Unrestricted="true" />  

 WebPermission is set in the web_mediumtrust.config file. To grant this 

permission, add the WebPermission class to the PermissionSet section of 

the web_mediumtrust.config file. 

Example: 

      <IPermission class="WebPermission" version="1" 
Unrestricted="true" />  

Note: The server where Sitebuilder is installed must work in the Full Trust mode. 

More detailed information about OleDbPermission you can find here 

(http://msdn2.microsoft.com/en-
us/library/ms998341.aspx#paght000020_oledbpermission). 

More detailed information about trust levels you can find here 
(http://msdn2.microsoft.com/en-us/library/wyts434y.aspx). 

 

http://msdn2.microsoft.com/en-us/library/ms998341.aspx#paght000020_oledbpermission
http://msdn2.microsoft.com/en-us/library/ms998341.aspx#paght000020_oledbpermission
http://msdn2.microsoft.com/en-us/library/wyts434y.aspx
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